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Bab 1. Pendahuluan  
 

Reference Emission Level merupakan tingkat emisi acuan yang 

diukur pada suatu wilayah yang disebabkan  dari kegiatan 

deforestasi dan degradasi hutan.  REL merupakan acuan dalam 

menghitung penurunan atau kenaikan emisi masa depan pada suatu 

wilayah.  Dalam skema REDD, angka ini akan menentukan, dengan 

membandingkan emisi aktual yang terj adi dalam suatu kurun  waktu 

tertentu, apakah suatu wilayah  berhasil ataukah tidak dalam upaya 

mitigasi perubahan iklim yang telah diupayakan . 

Berbagai metode telah tersedia dalam perhitungan tingkat emisi 

acuan ini. Masing -masing memiliki kekuatan, kelemahan, dan 

prakondisi ya ng berbeda. Pada modul ini penulis akan 

menyampaikan  proses perhitungan tingkat emisi acuan dengan 

menggunakan bahasa yang disederhanakan agar dapat difahami 

oleh berbagai fihak. 

Tujuan dari disusunnya modul ini adalah memberikan pemahaman 

teknis berbagai fihak, terutama pemerintah di daerah terkait 

cara/teknis perhitungan tingkat acuan emisi di daerahnya masing -

masing. Modul ini terdiri dari beberapa bab, dimana setiap chapter 

mewakili setiap proses yang diperlukan terkait dengan perhitungan 

REL, yang meliputi:  

Bab metode, memaparkan perbandingan setiap metode yang 

tersedia dalam perhitungan REL, keterkaitannya dengan data yang 

diperlukan, dan tahapan relatif dari proses proses identifikasi secara 

keseluruhan.  

Bab identifikasi kebutuhan dan sumberdaya , memapaparkan 

kebutuhan data, dan perangkat  yang diperlukan  dalam perhitungan 

REL. Kebutuhan spesifik jenis data dari setiap metode termasuk 

software maupun hardware yang diperlukan.  
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Bab identifikasi penutupan lahan memaparkan teknis identifikasi 

penutupan lahan menggunakan metode terpilih .  

Bab analisis perubahan penutupan lahan, deforestasi dan 

degradasi hutan , memaparkan teknik analisis perubahan penutupan 

lahan, identifikasi deforestasi dan degradasi hutan  dengan 

menggunakan software Arc GIS dan MS Excel. Definisi deforestasi 

dan degradasi hutan mengacu pada definisi dan kelas penutupan 

lahan yang digunakan pada kementerian kehutanan.  

Bab identifikasi sejarah emisi , memaparkan teknik estimasi emisi 

di masa lampau berdasarkan data perubahan penutupan lahan dan 

data cadangan karbon atau faktor emisi yang telah tersedia.  

Bab proyeksi emisi masa depan  BAU , memaparkan teknik proyeksi 

emisi dimasa depan BAU berdasarkan sejarah emisi masa lampau 

dengan menggunakan beberapa metode yang tersedia. 

Proses perhitungan REL secara umum disajikan pada bagan alur 

dibawah ini.  
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Gambar 1. Tahapan proses perhitungan REL 

Bab 2. Berbagai Metode REL yang Tersedia 
 

Merujuk pada informasi yang disajikan diawal, bahwa perhitungan 

proyeksi emisi dapat dilakukan dengan beberapa cara: [a] 

berdasarkan sejarah emisi dalam suatu kurun waktu tertentu, [b] 

berdasarkan sejarah emisi yang disesuaikan dengan suatu faktor 

penyesuai, [c] berdasarkan prediksi yang didasarkan pada rencana 

tata ruang wilayah dan r encana pembangunan/ekonomi, dan [d] 

berdasarkan model eksplisit spasial yang diinput oleh beberapa data 

proxy.  

Beberapa pilihan metode tersebut disajikan dalam bagan berikut ini:  
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Gambar 2. Bagan alur analisis teknis identifikasi REL (Sumber: UN -

REDD Indonesia, 2012) 

 

 

2.1. Historical Based  

 

Metode ini secara sederhana menggunakan emisi yang telah 

terjadi untuk memprediksi sejarah emisi di masa lalu. Sejarah 

emisi disintesis dari data perubahan penutupan lahan dan 

faktor emisi atau carbon density. Sehingga dalam hal ini, 

proyeksi merupakan f ungsi lanjutan dari sejarah emisi. 

 

Karakteristik  metode ini adalah: 

¶ Dibandingkan dengan metode lain, sejarah berbasis 

metode yang paling sederhana. 

¶ Hanya membutuhkan data sejarah tutupan lahan dalam 

kurun waktu tetentu.  
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¶ Secara umum, memiliki tingkat kebut uhan biaya biaya 

yang lebih rendah dibandingkan dengan metode lain.  

¶ Hanya memerlukanalat ( tool) Sistem Informasi Geografis 

yang sederhana dalam melakukan analisis / 

perhitungan nya. 

¶ Karena merupakan metode yang paling sederhana, 

metode mudah untuk dipahami oleh pemerintah daerah. 

¶ Metode ini menguntungkan bagi daerah yang memiliki 

angka sejarah emisi yang tinggi. 

¶ Metode ini tidak mempertimbangkan kebijakan 

pemerintah terkait dengan alokasi penggunaan lahan di 

masa depan. 

¶ Metode ini tidak mempertimbangkan hubu ngan dan 

dampak dari berbagai faktor yang mempengaruh i atau 

memicu perubahan tutupan lahan dimasa depan.  

¶ Metode ini tidak menguntungkan bagi daerah yang 

memiliki sejarah emisi yang rendah.  

 

 

 

 

 

2.2. Adjusted Historical Based  

 

Metode ini melakukan penyesuai an dari proyeksi yang 

didasarkan pada suatu faktor penyesuai. Faktor penyesuai 

tersebut dapat berupa kepadatan penduduk, laju 

pertambahan ekonomi, dll . 

 

Karakteristik metode ini adalah: 

¶ Mengakomodasi keadaan saat yang diwakili oleh 

beberapa faktor penyesuaian (kepadatan penduduk, 

pertumbuhan ekonomi, dll) untuk menyesuaikan emisi 

masa depan yang diproyeksikan. 

¶ Membutuhkan hanya dua set data: [1] sejarah tutupan 

lahan, dan [2] Faktor penyesuaian. 
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¶ Hanya memerlukan standar Geographics syatem 

Informasi dan alat  Penginderaan Jauh dalam melakukan 

analisisnya. 

 

¶ Terdapat beragam elemen faktor penyesuai yang bersifat 

kontekstual yang dapat beragam tergantung pada 

kondisi  daerah yang bersangkutan, sehingga elemen / 

parameter faktor penyesuai yang digunakan oleh setiap 

daerah dapat berbeda satu sama lain. 

 

 

2.3. Forward  Looking  

 

Metode forward looking merupakan metode yang 

memproyeksi emisi masa depan berdasarkan beberapa data 

proksi yang dimiliki. Berdasarkan teknis dan data yang 

digunakan, metode ini selanjutnya dapat  dibedakan menjadi 

forward looking parametrik dan forward looking non 

parametrik.  

 

Metode forward looking parametrik menggunakan 

pemodelan eksplisit spasial dalam memproyeksikan emisi 

masa depan. Data yang digunakan meliputi data yang dinilai 

berpotensi menjadi trigger dari deforestasi dab degradasi 

hutan, seperti jaringan jalan, jaringan sungai, kelerengan, 

ketinggian, dll. Contoh model yang tersedia adalah geomod 

dan land change modeller.  Sementara itu, metode forward 

looking non parametrik melakukan  proyeksi emisi masa 

depan dengan mendasarkan berbagai skenario yang merujuk 

pada rencana pengembangan wilayah atau tataruang serta 

dokumen rencana pembangunan dan ekonomi setempat. 

 

Karakteristik metode ini  adalah: 

¶ Skenario yang didasarkan pada rencana tata ruang lokal 

untuk membuat metode ini minggu relatif mudah untuk 
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mendiskusikan dengan pemerintah daerah, terutama 

dalam hal strategi pengurangan emisi. 

¶ Metode ini mudah dipahami oleh pemerintah daerah 

untuk proyeksi emisi didasarkan pada data spasial dan 

rencana pembangunan yang relevan daerah. 

¶ Karena mempertimbangkan rencana pengembagan 

wilayah dan pembangunan daerah setempat, maka 

metode ini oleh beberapa pihak dianggap mewakili 

kepentingan ekonomi dan pertumbuhan daerah yang 

bersangkutan. 

¶ Metode ini diangg ap oleh beberapa pihak adalah cukup 

komprehensif untuk menggunakan berbagai proxy data 

dalam memproyeksikan emisi masa depan. 

 

¶ Metode ini memerlukan analisis yang lebih kompleks 

diandingkan dengan metode lainnya, sehingga 

memerlukan keterampilan teknis yan g relatif tinggi.  

¶ Metode ini membutuhkan tingkat keragaman data yang 

lebih tinggi dibandingkan dengan metode lainnya.  

¶ Memerlukan tool SIG dengan ekstensi pemodelan 

spasial. 

¶ Merujuk kepada kebutuhan tools atau model yang 

disyaratkan, kompleksitas,  serta tingkat keragaman data 

yang tinggi, menjadi kan metode ini memerlukan biaya 

yang relatif lebih mahal dibandingkan dengan metode 

lainnnya.  

 

Secara umum kekuatan dan kelemahan masing-masing konsideran 

tersebut disajikan pada tabel dibawah ini.  

Konsideran  Metod e 

Historical 

Based 

Metode 

Adjusted 

Historical 

Based 

Metode 

Forward 

Looking 

Non -

parametric  

Metode 

Forward 

Looking 

Parametric 
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Kompleksitas  Sederhana Sederhana Moderate  Kompleks  

Tingkat kebutuhan 

data 

Sederhana Moderate Tinggi  Tinggi  

Perangkat analisis Moderate  Moderate  Moderate  Relatif tinggi  

Kemudahan difahami 

pemerintah daerah 

Mudah  Moderate  Mudah  Relatif sulit  

Mempertimbangkan 

rencana pembangunan 

dan pengembangan 

wilayah daerah  

Rendah Rendah 

 

Tinggi  Moderate  

Kemudahan dalam 

menyusun strategi 

penurunan emisi 

berbasis lahan 

Moderate  Moderate  Relatif mudah  Moderate 

 

 

 

 

 

Bab 3. Inventarisasi Kebutuhan  dan Sumberdaya  
 

Inventarisasi kebutuhan dan sumberdaya meliputi data, perangkat lunak, 

dan perangkat keras. Inventarisasi kebutuhan dan sumberdaya ini 

selanjutnya akan dijadikan sebagai dasar dalam mengidentifikasi gaps 

terkait data dan perangkat perlu dipersiapkan wilayah yang bersangkutan 

dalam melakukan perhitungan REL.  

 

3.1. Perangkat 
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Perangkat atau alat yang diperlukan dalam perhitungan REL 

akan sangat bergantung dengan metode yang digunakan. 

Berikut tabel kebutuhan alat atau perangkat yang diperlukan 

dalam perhitungan REL pada berbagai metode. 

 

Perangkat 
/ Peralatan 

Historical Based  Adjusted 
Historical Based  

Forward Looking 
Non Parametrik  

Forward Looking 
Parametrik  

Software  Software SIG (Arc 
GIS, Q GIS, dll) 
 
Software 
Penginderaan 
Jauh (ENVI, ER 
Mapper, dll)  
 
Software 
Microsoft Office 
(MS Excel dan MS 
Word)  

Software SIG (Arc 
GIS, Q GIS, dll) 
 
Software 
Penginderaan 
Jauh (ENVI, ER 
Mapper, dll)  
 
Software 
Microsoft Office 
(MS Excel dan MS 
Word)  

Software SIG (Arc 
GIS, Q GIS, dll) 
 
Software 
Penginderaan 
Jauh (ENVI, ER 
Mapper, dll)  
 
Software 
Microsoft Office 
(MS Excel dan MS 
Word)  

Software SIG (Arc 
GIS, Q GIS, dll) 
 
Software 
Penginderaan Jauh 
(ENVI, ER 
Mapper, dll)  
 
Explicit spatial 
model 
 
Software Microsoft 
Office (MS Excel 
dan MS Word) 

 
Hardware  

Personal 
Computer, 
spesifkasi 
minimal yang 
dianjurkan adalah 
RAM 2 GB dan 
kartu grafis 1 GB 

Personal 
Computer, 
spesifkasi 
minimal yang 
dianjurkan adalah 
RAM 2 GB dan 
kartu grafis 1 GB 

Personal 
Computer, 
spesifkasi 
minimal yang 
dianjurkan adalah 
RAM 2 GB dan 
kartu grafis 1 GB 

Personal 
Computer, 
spesifkasi minimal 
yang dianjurkan 
adalah RAM 2 GB 
dan kartu grafis 1 
GB 

 

 

3.2. Data 

 

Seperti hal nya perlengkapan dan peralatan, kebutuhan data 

akan juga sangat bergantung pada metode yang digunakan. 

Berikut tabel kebutuhan data dari berbagai metode yang 

diperlukan.  

 

 Historical 
Based 

Adjusted 
Historical 
Based 

Forward 
Looking 
Non 
Parametrik  

Forward 
Looking 
Parametrik  

Peta Sejarah 
penutup 
lahan 

ã ã ã ã 
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Peta Tata 
Ruang 
Wilayah  

  ã  

Peta 
Penunjukan 
Kawasan dan 
Perairan 

  ã  

Peta 
Perkebunan 

   ã 

Peta 
Pertambangan 

   ã 

Peta Jalan    ã 

Peta Sungai    ã 

Peta Batas 
Administrasi  

ã ã ã ã 

Peta 
Ketinggian  

   ã 

Demografi   ã   

Rencana 
Pembangunan 
Jangka 
Menegah 
Daerah 

  ã  

 

 

 

 

 

Pengumpulan data dilakukan kepada setiap wali data yang 

bersangkutan. Berikut daftar wali data untuk beberapa data 

terkait.  

 

Wali/Sumber Data  Daftar data  

BPHK Peta Penutup Lahan, Peta 
KPK, Peta Penunjukan 
kawasan dan perairan 

Bakosurtanal Peta Administrasi  

USGS Peta Ketinggian yang 
disintesis dari SRTM 

Dinas Pekerjaan Umum Peta Rencana Tata Ruang 
Wilayah, Peta Jalan 

Bappeda Dokumen Rencana 
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Pembangunan Jangka 
Menengah, Peta Administrasi  

Biro Pusat Statistik Data Demografi 

BPDAS Peta Jaringan Sungai 

Dinas Perkebunan Peta Perkebunan 

Dinas Pertambangan Peta Pertambangan 

 

 

 

 

 

 

 

 

 

 

Bab 4. Identifikasi  Penutupan Lahan  
 

4.1. Teknik interpretasi citra satelit  
 

Analisis perubahan penutupan lahan dan identifikasi perubahannya 

merupakan bagian dari data aktivitas yang harus disiapkan dalam 

perhitungan emisi. Identifikasi penutupan lahan dilakukan dengan 

melakukan interpretasi citra satelit. Melalui sensor yang dimilikinya, 

menggunakan gelombang elektromagnetik, citra satelit merekam fenomena 

permukaan bumi secara berkala. Perekaman ini memanfatkan perbedaan 

selang spektral yang dipantulkan. Beragam citra satelit yang tersedia saat 

ini; optik maupun radar, dengan berbagai tingkatan resolusi spasial.  
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Citra satelit dapat diinterpreta si melalui beberapa cara: [a] interpretasi 

manual (manual interpretation), dan [b] interpretasi digital ( digital 

interpretation). Interpretasi manual dilakukan secara visual menggunakan 

meja digitasi (digitation tablet) ataupun digitasi on screen (on screen 

digitation), sementara interpretasi digital dilakukan menggunakan sistem 

yang terkomp uterisasi berdasarkan dengan atau tanpa menggunakan 

sample atau alghorithma yang telah pengguna tetapkan. 

Terkait dengan interpretasi digital, ada dua kelompok ektraksi data: [a] 

berbasis piksel, dan [b] berbasis objek (object oriented classification). 

Interpretasi berbasis piksel meliputi klasifikasi terbimbing ( supervised 

classification) dan klasifikasi tidak terbimbing ( un-supervised classification). 

Klasifikasi terbim bing adalah metode klasifikasi berdasarkan sample yang 

telah ditentukan olah pengguna, sementara klasifikasi tidak terbim bing 

akan memberikan keleluasaan kepada komputer untuk mengklasifikasikan 

kelas yang junlahnya telah pengguna tentukan untuk kemudian h asilnya 

didefinisikan selanjutnya berdasarkan atribut kelas yang telah ditentukan.  

Dalam klasifikasi terbimbing terdapat beberapa metode yang dapat 

digunakan:  

- Maximum likelihood; mengasumsikan bahwa statistik kelas pada setiap 
band terdistribusi secara normal. Kelas piksel ditentukan berdasarkan 
tingkat probabilitas tertinggi.  

 

- Minimum distance; menggunakan nilai tengah untuk setiap kelas dan 
menghitung jarak Euclidean dari piksel yang tidak diketahui ke nilai 
tengah tengah masing-masing kelas. Piksel diklasifkasikan berdasarkan 
kelas yang terdekat.  

 

- Mahalanobis distance; memiliki kemiripan dengan maximum 
likelihood, namun mengasumsikan bahwa semua kovarian kelas adalah 
setara. Semua piksel diklasifikasikan kepada data training yang 
terdekat. 

 

- Spectral Angle Mapper (SAM); adalah klasifikasi fisik berbasis spektral 
yang menggunakan sudut nD untuk mencocokkan piksel data sample. 
Teknik ini  relatif tidak sensitif terhadap efek pencahayaan dan Albedo. 
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SAM membandingkan sudut antara setiap piksel dengan rerata 
samplenya dalam ruang nD. Sudut yang lebih kecil merupakan 
pertanda jarak yang lebih dekat dengan spektrum sample. Piksel dalam 
hal ini diklasifikasikan ke dalam kelas yang memiliki sudut terkecil . 

 

Klasifikasi berbasis piksel merupakan metode klasifikasi kl asik yang 

mengolah spektral menjadi informasi pada setiap piksel. Secara normal 

perbedaan fisik pada permukaan bumi akan memiliki informasi spektral 

yang khusus. Namun, pendekatan ini memiliki keterbatasan ketika objek 

memiliki informasi spektral yang sama  (Gao Yan, 2003). 

Klasifikasi berbasis objek (object oriented classifictaion) adalah interpretasi 

citra yang menggabungkan informasi spektral dan informasi spasial. 

Pendekatan ini membuat segmentasi piksel menjadi objek sesuai dengan 

rona dan mengklasifika sikannya sebagai gambar secara keseluruhan. 

Klasifikasi berbasis pixel menggunakan nilai spektral, sementara klaisfikasi 

berbasis objekjuga menggunakan informasi  tekstur dan konteks dalam 

menentukan segmen kelas objeknya. Atas pertimbangan hal tersebut dia tas, 

pada panduan teknis ini, akan coba disampaikan teknik metode klasifikasi 

citra dengan metode digital berbasis objek. Perangkat yang digunakan 

adalah perangkat lunak ENVI  dan ArcGIS. 

 

 

Tahapan yang dilakukan dalam interpretasi ini digambarkan pada diag ram 

dibawah ini:  



 

15 

 

Pengolahan 

awal citra

Segmentasi

Identifikasi 

training area

Klasifkasi

Penghitungan 

akurasi

Ya

Tidak

Vektorisasi

 
 

Gambar 3. Klasifikasi citra berbasis objek 

 

 

 

4.2. Pengolahan awal citra  
 

4.2.1. Pembuatan data set citra  
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Dalam format aslinya, sebagian data mentah citra disiapkan terpisah dalam 

masing-masing band.  Sehingga dipelukan satu langkah untuk 

mengkonversi sekaligus menggabungkan band yang diperlukan kedalam 

satu dataset citra. Dibawah ini adalah urutan langkah yang dilakukan 

dalam membuat dataset dengan menggunakan contoh citra satelit landsat. 

 

- Aktifkan  software Arc Map  (start>program>Arc GIS>Arc Map)  
 

- Aktifkan  òArc Toolboxó melalui menu tool : Window . 

 
 

- Tool òComposite Bandsó dapat diakses dengan membuka Arc Toolbox>  
Data Management Tools> Raster> Raster Processing>Composite Bands 

 

 

- Dalam jendela komposit band, pilihlah input raster yang memiliki 
angka band yang sesuai dengan kebutuhan untuk dimasukan dalam 
kanal RGB lalu klik  OK.  
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Setiap tipe band memiliki karakter merekam tipe objek tertentu. Dibawah 
ini adalah contoh fungsi setiap band dari citra Landsat.  

Band Contoh aplikasi  

1 Pemetaan wilayah pantai dan perairan, pembuatan batimetri, 
pemetaan sedimentasi 

2 Pemetaan vegetasi, identifikasi reflektansi klorofil  

3 Identifikasi absorbsi klorofil, pembedaan spesies tumbuhan, 
dan biomasa 

4 Spesiaes  vegetasi, biomasa, kelembaban tanah 

5 Pembatasan fenomena tanah dan tumbuhan, pemetaan 
wilayah pemukiman  

6 Pemetaan evapotranspirasi, pemetaan suhu permukaan, 
kelembaban tanah 

7 Geologi, pemetaan tipe batuan dan mineral, pembatasan 
badan air, pemetaan tingkat kelembaban tumbuhan 

 
 

- Pada panduan teknis ini, band 543 akan digunakan sebagai contoh. 

Selain band yang berkesesuaian dengan kebutuhan identifikasi 

penutupan lahan, kombinasi ini memberikan informasi dan kombinasi 

warna yang kontras, vegetasi hijau dan tanah berwarna merah. 

Kombinasi band ini umum digunakan untuk kebutuhan kegiatan 

monitoring hutan.  

 

- Apabila dataset telah terbentuk maka, maka band dapat dilihat 

keberadaannya dengan meng klik kanan diatas image, lalu pilih 

properties. Pada jendela simbology, pilihlah RGB composite. 
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- Langkah selanjutnya adalah melakukan penggabungan citra, atau 

mosaicking. Mosaic tool dapat di akses melalui Arc Toolbox>Data 

Management Tool>Raster>Raster Dataset>Mosaic To New Raster 

 

 

- Pada jendela òMosaic to New Rasteró, input rasteryang akan di mosaic. 
Tentukan lokasi , nama field, sistem koordinat , lalu klik OK . 
 

4.2.2. Koreksi Geometrik  

 

Data Landsat sebagian kini sebagian besar didistribusikan dalam format 

citra yang telah di orto -rectifikasi. Namun, jika dalam situasi citra belum 

ter-rektifikasi, maka rektifikasi citra dalam hal ini dapat dilakukan dalam 
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ArcGIS dalam tool geo-referncing, melalui menu 

Tools>Customize>toolbar>Georeferencing. 

 

 

 

4.2.3. Koreksi Radiometrik  

 

Koreksi radiometrik merupakan proses yang dilakukan unt uk 

meningkatkan tingkat visibilitas citra sebelum diinterpretasi. Dalam ENVI 

EX, koreksi radiomatrik dapat dilakukan dengan cara:  

- Melalui software ENVI EX buka  jendela òData Manageró melalui menu  
òFileó 

 

 

- Buka file citra lalu pilihlah komposisi band yang akan digunakan 
sebagai visualisasi. 



 

20 

 

 

 

- Koreksi Radiometrik  selanjutnya dapat dilakukan melalui tool 
histogram scrath dan filter yang ada pada tool, atau dapat juga 
menggunakan teknik yang sangat sederhana dengan menyesuaikan tool 
bright, cont rast, atau sharpen.  

 

 

4.3. Klasifikasi Citra  
 

Tahapan teknik klasifikasi citra dilakukan dengan cara:  

-  Buka menu File >Open untuk membuka citra . 
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- Bukalah òData Manageró dari menu File, kemudian pilihlah band 
komposit RGB, lalu buka  òLoad Dataó 

 

 

 

4.3.1. Segmentasi 

 

Tahapan selanjutnya dari proses klasifikasi citra berbasis objek adalah 

segmentasi. Segmentasi merupakan tahapan yang mengkelompokkan 

piksel berdasarkan tingkt homogenitas dan heterogenitas warna dan 

bentuknya.  

Segmentasi dilakukan dengan cara: 

- Pada menu Toolbox ENVI , bukalah Workflows>Feature Extraction  

 

- Segmentasi dapat berjalan dalam berbagai skala paramaeter. Pada 
tahapan ini pengujian pada berbagai tingkat diperlukan untuk melihat 
hasil yang terbaik.  
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Berikut adalah contoh segmentasi yang dilakuk an pada empat skala 

segmentasi yang berbeda (25, 40, 50, dan 75): 

 

 

 

Semakin kecil skala paramater semakin tinggi dimensi dan pembagian 

objek yang dilakukan. Dengan menguji parameter segmentasi yang 

berbeda, mengacu pada pembandingan visual, atau pengecekan lapangan, 

atau pengetahuan lapangan, maka salah satu parameter segmentasi 

selanjutnya dapat ditentukan  (Matinfar, 2007).  
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- Mengacu pada hasil diatas skala paramater 40 misalnya memberikan 

hasil yang terbaik, maka skala ini selanjutnya dipilih untuk da n dibawa 

pada proses selanjutnya. 

- Tentukan band yang akan dipilih, misalnya 543, kemudian pilik OK.  

 

- Contoh hasil segmentasi adalah seperti gambar dibawah ini.   

 

 
- Langkah selanjutnya dari segmentasi adalah majorisasi. Proses ini 

merupakan tahapan yang optional yang akan menggabungkan 
segment-segment kecil yang homogen menjadi segment yang lebih 
besar. Majorisasi dalam hal ini diwakili oleh proses merge. Dalam 
contoh ini contoh proses merge tidak akan dilakukan, sehingga merge 
level diset pada angka 0, lalu k lik next.  
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- Pada tahap òrefineó, threshold parameter dapat digunakan berdasarkan 
interval nomer digital yang kita tentukan.  

 

 

- Pada tahap òcompute attributesó, pilihlah parameter yang akan 
digunakan dalam mendefinisikan atribut dari objek yang akan 
di lakukan. Pada klasifikasi berbasis piksel yang digunakan hanya 
paramater spektral, sementara pada klasifikasi berbasis objek paramater 
tekstur , spasial, spektral digunakan secara komprehensif. Kemudian 
pilihlah next untuk melanjutkan pada proses segmentasi  final . 
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4.3.2. Identifikasi Training Area  

 

- Langkah selanjutnya adalah ekstraksi feature. Pada tahapan ini 
penentuan beberapa segment sebagai sample kelas jenis penutupan 
lahan dilakukan.  

 

 
- Pada tahapan ini tentukan jumlah dan nama kelas yang digunakan . 
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- Penambahan kelas dan perubahan nama dilakukan melalui tool berikut  
(contoh: hutan mangrove , hutan rawa sekunder , perkebunan, lahan 
terbuka, dll .) 

 

 

- Pada tahap ini penentuan sample tipe penutupan lahan pada beberapa 
segment dilakukan. 
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4.3.3. Klasifikasi   

 

Selanjutnya klasifikasi citra akan memproses dan menentukan segment 

yang ada untuk masuk kedalam kelas berdasarkan sample yang telah 

ditentukan.  

- Dibawah ini adalah contoh sample kelas yang dijadikan dasar dalam 
klasifikasi.  

 

 

- Hasil kemudian diek spor kedalam vektor.  

 

 














































